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Updates to the
Desktop Messaging User Guides

Internet Clients
Page 7 Call the sender of a message
Call the sender of a message is not supported.

Page 7 Access web-based My CallPilot to view user information and change your 
feature settings
My CallPilot is not supported.

Page 8 About this guide
The Internet mail clients that are supported are:

• Microsoft Outlook 2000 (Internet mail mode)

• Microsoft Outlook 2002 (XP) (Internet mail mode)

• Microsoft Outlook 2003 (Internet mail mode)

• Microsoft Outlook Express - 5.x and 6.x

• Netscape Messenger (Netscape Communicator) - 6.2x

• Netscape Mail - 7.0x

• Qualcomm Eudora Pro - 6.1.2

Citrix (Terminal server) functionality is supported.

Page 11 CallPilot Player
The Call the sender button is not available.

Page 11 To select your telephone or computer to play voice messages
If your telephone is call forwarded to voicemail, cancel this feature before you access your 
messages from CallPilot Player.

Page 29 Linking to My CallPilot
Linking to My CallPilot is not supported.

About forwarding Desktop Messaging messages
Do not use the right-click menu to forward a Desktop Messaging message. To forward a 
message, either:

• open the message and forward it from the CallPilot window

or

• for Outlook, select the message in the Outlook Inbox and forward it from the Outlook 
toolbar.



Outlook, Lotus Notes, GroupWise
Page 7 Call the sender of a message
Call the sender of a message is not supported.

Page 7 Access web-based My CallPilot to view user information and change your feature settings
My CallPilot is not supported.

Page 8 About this guide
The groupware e-mail clients that are supported are:

• Lotus Notes - 5.x and 6.x

• GroupWise - 6.x

• Microsoft Outlook 2000, 2002 (XP), and 2003

Citrix (Terminal server) functionality is supported.

Page 11 (Page 12 Lotus Notes) CallPilot Player
The Call the sender button is not available.

Page 11 (Page 12 Lotus Notes) To play a message from your telephone
If your telephone is call forwarded to voicemail, cancel this feature before you access your messages from 
CallPilot Player.

Page 14 (Page15 Lotus Notes) Composing fax and text messages
On the Compose Fax dialog box you can use the Subject field to add additional information to the fax cover page 
(for example, the name of the recipient) when you send a fax directly to a fax machine. The maximum length you 
can enter in the Subject field is 80 characters.

Page 27 (Page 28 Lotus Notes) Calling the sender of a message
Calling the sender of a message is not supported.

Page 28 (Page 29 Lotus Notes) Setting message options
Delivery Receipt is not supported.

Page 31 (Page 34 Lotus Notes and Microsoft Outlook) Personal distribution lists
Personal Distribution lists are not supported.

Page 37 (Page 40 Lotus Notes and Page 39 Microsoft Outlook) Linking to My CallPilot
Linking to My CallPilot is not supported.
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Welcome to CallPilot
CallPilot from Nortel Networks is an advanced business communications 
system that offers exceptional flexibility for managing your messaging 
needs. 

You can work with CallPilot from your telephone or your computer. 
Desktop Messaging gives you access to your CallPilot mailbox through 
your Lotus Notes e-mail. Here are some of the many ways you can use 
CallPilot with your e-mail:

Listen to voice messages.
View and print fax messages.
Record and send voice messages.
Create and send fax messages.
Forward and reply to voice and fax messages.
Call the sender of a message.
Add message options such as urgent and private.
Add voice, fax, or text file attachments to messages.
Create CallPilot distribution lists.
Change your CallPilot password.
Access web-based My CallPilot to view user information and change 
your feature settings.

Some features mentioned in this guide may not be available for your 
CallPilot mailbox. For details, refer to the Feature availability topic in the 
Desktop Messaging online Help, or ask your administrator.
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Getting started

About this guide
This user guide is an overview of how to use CallPilot with Lotus Notes e-mail. 

The instructions and screen images shown in this guide provide general information for 
using CallPilot with e-mail. Specific details may vary depending on your computer’s 
operating system and the features available for your CallPilot mailbox. 

For further assistance in using CallPilot, refer to the Desktop Messaging online Help.

What you need
Before you start to use CallPilot, your administrator ensures that your e-mail account is 
correctly configured for CallPilot. Your computer must meet the following configuration 
requirements:

CallPilot Player to play and record voice messages

Nortel Fax Driver to create faxes

Lotus Notes 5.xx and 6.xx groupware e-mail client
Windows 98 SE, Windows 2000 Professional, or Windows XP 

Monitor with 256-color 800 x 600 capability 

15 Mbytes of free disk space to install software 
Sound card and speakers for playing voice messages on your computer 

A microphone connected to your computer, or a telephone situated near your 
computer, for recording voice messages 
A LAN (Ethernet), ISDN, ADSL, or dial-up modem connection to the CallPilot 
server for accessing CallPilot messages
Internet Explorer 5.x and 6.x; or Netscape 6.2x and above, to access My CallPilot 

Operating in a Citrix Thin Client environment from a Windows Terminal Server
Once the administrator has installed CallPilot Desktop Messaging on the Windows 
Terminal Server and updated mail databases on the Domino server, Citrix Thin Client 
users can run the CallPilot-enabled Lotus Notes client. 

When a Lotus Notes Client starts for the first time after the server configuration is 
completed, CallPilot Desktop messaging detects updated mail database, makes all 
required modifications in the Lotus Notes client initialization file (NOTES.INI) and 
prompts the user to finalize the configuration by restarting the Lotus Notes client.
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Logging in
When you log in to your e-mail, you can log in to CallPilot at the same time.

To log in from Lotus Notes

Note: Do not leave the Remember password box checked on a shared computer.

Note: CallPilot Desktop Messaging does not support multiple Lotus Notes logins to 
the same mailbox from more than one computer.

To log out
When you exit your Lotus Notes e-mail, you automatically log out from CallPilot.

Remote login
You can log in to your mailbox from any computer that has CallPilot installed and 
configured in the same way as your office computer. For example, you can use a 
computer set up for guest access, or your home computer with a dial-up connection to 
the server.

Multiple Lotus Notes mail database support
CallPilot allows a Lotus Notes user to change mail databases on the fly, either at startup 
or during an active session.

Startup
If you open a different mail database on Lotus Notes client startup than the one you 
used in your previous session, CallPilot Desktop Messaging detects this and 
synchronizes to the new database automatically.

Changing your mail database during the active session
You can also change the mail database you are using during the currently active Lotus 
Notes and CallPilot session (that is, when you are logged on to a Lotus Notes mail 
database and are an active CallPilot client).

 

1 Open your Lotus Notes e-mail.

The CallPilot Logon dialog box 
appears when you open 
CallPilot Desktop Messaging in 
Lotus Notes 5.xx or later.

2 In Mailbox, type or select your 
mailbox number.

3 In Password, type your CallPilot 
password.

4 Check Remember password if 
you want CallPilot to log in 
automatically.

5 Click OK.



10

You change the mail database by either:

1 Accessing the CallPilot Desktop Messaging view in the different Lotus Notes mail 
database. CallPilot Desktop Messaging detects this and warns you that CallPilot 
is connected to a different mail database. If you choose to connect to the other 
database, click the Yes button in the dialog box and CallPilot will synchronize to 
the new mail database. If you answer No, no synchronization occurs. To use 
CallPilot in this case, you have to switch back to the mail database that CallPilot 
Desktop Messaging is already synchronized with.

OR 

2 By trying to run CallPilot commands (that is, open a message, use menu items, 
etc.)  in a mail database different from the one CallPilot is already synchronized 
with. CallPilot Desktop Messaging detects this and warns you that CallPilot has 
to synchronize with the new mail database before implementing the command. 
When you click on OK, the synchronization occurs and when it is complete, you 
can run the CallPilot command again.
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Working with your CallPilot messages
When you open your e-mail with CallPilot installed, your CallPilot messages appear in 
the CallPilot Desktop Messaging folder. 

Your CallPilot Inbox

To check for new messages
The CallPilot message waiting indicator on your screen turns red when you have 
a new message. To turn the indicator on or off, see Changing mail delivery 
settings, on page 40. New messages appear in red.

To open a message
To open a CallPilot message, double-click the message line. See Playing voice 
messages, on page 12, and Viewing fax messages, on page 13.

To delete a message
If you are using Lotus Notes 5.xx to mark a message for deletion, click on a 
CallPilot message in your Inbox to select it, then click the Delete icon on the 
toolbar. To permanently delete messages, select the Actions menu, click Empty 
Trash. In Lotus Notes 6.xx, the message is deleted as sson as you click on 
Delete.

Note: You can delete a message immediately by clicking the Delete icon in an open 
CallPilot message. 

 Private
message

Urgent
message

New message

Attached files
(voice, fax, text)

Message was 
received 

Message was 
opened by the 
recipient



12

Playing voice messages
When you open a voice-only message, the CallPilot Player appears. In mixed 
voice and fax or text messages, click the Voice icon to open the CallPilot Player.

To select your telephone or computer to play voice messages
You can choose to play your voice messages from your telephone or your computer. To 
change from one to the other, or to change the telephone number that CallPilot dials, 
see Changing audio settings, on page 44. You can also click the Telephone or 
Computer icon on the CallPilot Player to change the setting. 

To play a message from your telephone
1 To play a voice message when your telephone is selected for playback, double-

click the message in your CallPilot Inbox and answer your telephone when it rings. 

2 Use the buttons on the CallPilot Player to play or stop the message, go backward 
and forward, and call the sender. 

3 When you are finished, hang up and close the message.

To play a message from your computer
1 To play a voice message when your computer is selected for playback, double-

click the message in your CallPilot Inbox.

The message plays through your computer’s speakers or your headphones. 
2 Use the buttons on the CallPilot Player to play or stop the message, go backward 

and forward, adjust the volume and speed, and call the sender. 

3 When you have finished, close the message.

Play Back
Slider

Play/Re-play

Stop

Play messages
from telephone

Play messages
from computer

Close 
message

Reply to All

Delete 
message

Record 
Message

Disconnect

Call the 
sender

Go to start/ 
Skip back 

Go to end/ 
Skip forward

Adjust 
speed

Adjust
volume

Attach File

Address
TO, CC, BCC
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Viewing fax messages
Note: In order to receive faxes, your CallPilot administrator must enable fax 
capability for your mailbox.

To view a fax message 
1 Double-click a fax message in your CallPilot Inbox. When you open a fax-only 

message, the fax image appears right away. In mixed voice and fax or text 
messages, click the Fax icon to view the fax.

2 While viewing the fax, you can enlarge or reduce the image, rotate or move it, 
print it, delete it, save it, forward it and reply to it.

3 When you have finished, close the message.

Close 
message

Reply to All
Reply
Forward

Change page 
views

Go to next or 
previous page

Rotate left
Rotate right

Zoom in
Zoom out

Print

Delete
message

Select part of
image

Drag/scroll
image
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Composing voice messages
You can record a voice message from the computer or the telephone, then address and 
send it the same way as an e-mail message. 

To record and send a voice message 
1 In your CallPilot Inbox, click the New CallPilot Message button.

2 On the new message form, click the Telephone icon in the toolbar to open the 
CallPilot Player, if it is not already open. 

3 On the CallPilot Player, click the red Record button to start recording.
4  If you are recording from the computer, record your message into the 

microphone. Click Stop to end the recording. Click Play to review it. To add to 
the recording, click Record, speak again, then click Stop.

 If you are recording from the telephone, answer when it rings. At the tone, 
record your message. Click Stop to end the recording. Click Play to review it. 
To add to the recording or re-record it, move the playback slider to the desired 
position, click Record, speak again, then click Stop. Hang up the telephone.

5 Click To… to address from an address book. See Addressing messages, on 
page 34. Or type a formatted address in the To... field.

6 Add attachments and options if required. See Adding attachments to messages, 
on page 33, and Setting message options, on page 33.

7 On the toolbar, click the Send Message icon.

To save a newly created voice message as a file
1 On a new message form, record a message, and on the File menu, click Save as... .
2 In the File name box, type a name for the file, select a folder to keep the file in, 

then click Save. Save voice files as .vbk files. Note: CallPilot automatically 
converts .vbk files to .wav files when sending to non-CallPilot users. See 
Changing mail delivery settings, on page 40.

Send message

Save message

Address
message

Set options

Playback slider

Play

Stop

Record from
telephone

Record from
computer

Attach file

Telephone icon 
opens CallPilot 
Player

Go back Go forward

Record

Adjust speed Adjust volume
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Composing fax and text messages

To create and send a single fax message 
To create a fax, your CallPilot mailbox must have fax capability. The CallPilot recipients 
of your fax must have mailbox capability to receive the fax on their computer. If your 
recipients access their messages from their telephone, they can view the fax only by 
printing it. You can also send your fax to a fax machine.

1 Open the document that you want to fax. It must be 8.5 in. (21.5 cm) wide or less.

2 On the File menu, click Print.
3 From the list of printers, select Nortel Fax, then click Print or OK. 

4 The Compose Fax dialog box appears. Before sending the fax, you can add 
more documents by repeating steps 1 to 3. You can also choose to include a 
cover page, view the fax, and save it as a file for later transmission.

5 Select an appropriate Send using... option. 

To send a simple fax, type the fax machine number(s) or CallPilot mailbox 
number (‘m’ plus number, for example, m7366) in the Fax machine(s) field, type 
a subject in the Subject field, then click Send. 
To send your fax as an attachment to a new CallPilot message, select CallPilot 
Desktop Messaging for Lotus Notes under Send using, then click Send. 

A new message form opens with your fax file attached. Address the message 
from the CallPilot, e-mail, or any Address Book. See Addressing messages, on 
page 34. Or type the formatted address in the To... field

F i l e  n a m e

S e n d  f a x
o p t i o n s

C o v e r  p a g e
o p t i o n  s e l e c t i o n

S a v e  t o  s e n d
l a t e r

V i e w  b e f o r e  
s e n d i n g

D e l e t e  b e f o r e
s e n d i n g

C h a n g e  o r d e r
o f  f i l e s  t o  b e  
f a x e d



16

6 Add attachments and options if required. See Adding attachments to messages, 
on page 33, and Setting message options, on page 33.

7 Click the Send Message icon.

To create and send a text message
To create a text message, open a new CallPilot message form and type or paste plain 
text into it, address the message, then click the Send Message icon. 
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Creating and sending fax batch messages
To send customized CallPilot fax messages to multiple recipients you can use Microsoft 
Word's Mail Merge and send your print job to the Nortel Fax Batch printer. You must be 
familiar with Microsoft Word's Mail Merge functionality to use this feature. Consult your 
MS Word documentation. Note that the CallPilot Fax Batch feature is only available to 
CallPilot Desktop and Web users who install the Nortel Fax Batch Print Driver.

To use Mail Merge with CallPilot, you will need your main document (the file you want to 
send to your recipients) and a data source document which contains recipient 
information such as names and fax numbers. 

Your Callpilot Desktop Messaging installation includes an example Microsoft Word data 
source named Data.doc and an example Microsoft Word main document named 
Sample.doc. Each of these are examined below to explain the batch fax procedure. 

Accessing and modifying the example Data source document
The Data.doc file consists of a Microsoft Word table. It is organized in columns, with one 
row for each recipient. The following column headers exist in the sample: ToFax, 
ToName, DelReceipt, DelType, ToCompany, and ToPhone. These column headers can 
be modified, deleted and new columns can be added.   The column header names 
serve as tags that can be inserted into the main document to customize the fax for each 
recipient or to direct CallPilot how to handle the fax.
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1 Go to \Program Files\Nortel Networks\CallPilot\nda directory and open the 
Data.doc file.

2 Add new columns or subtract existing ones, as required. For new columns, chose 
a meaningful column header name.

3 Add the required data under each column header. The data source can be 
created by any means available to populate a Microsoft Word table, including 
importing information from existing files. 

If you edit the recipient list using the Mail Merge utility (i.e. click on Edit in the Data 
source section of the MS Mail Merge Helper), the Data Form window opens and 
lists all the entries from the data source table. You can add, delete, modify and 
search for records in this window. Any column headers that you added or modified 
in the data source file will automatically appear in this window. Note that the ToFax 
field is the only mandatory field for CallPilot. 

The following parameters and characters are supported in the ToFax field:

Maximum supported length for the fax phone number is 120 characters.

Numbers 0 through 9 are supported.

Upper and lower case P and the comma are used when a pause is 
necessary.

The Pound sign (#) is used by some fax servers and is supported.
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Common phone number symbols such as left and right parentheses and the 
dash are supported.

Spaces are supported.
Upper and lower case M used in front of a CallPilot mailbox number to 
designate the address as a CallPilot mailbox are supported.

The other fields are optional and are used to customize the fax or to direct CallPilot 
how to handle it. Three specific CallPilot fields and their parameters are:

ToName: This is the fax recipient’s name and can be up to 256 characters 
in length.

DelReceipt: You can use this tag to receive a Delivery Receipt in the form 
of a CallPilot message in your CallPilot mailbox when the fax is delivered to 
the recipient. If the DelReceipt field is set to “1”, then a delivery receipt will 
be generated. If DelReceipt is set to '0', a delivery receipt will not be 
generated for that recipient. If the DelReceipt field is empty or the field is not 
in Data.doc, then no delivery receipt will be generated.
DelType: This field may be used to set a delivery priority for each recipient. 
If the DelType field is set to '0' or is left empty (or if it is not present in your 
Data.doc), the message will be tagged for Normal delivery. If DelType is set 
to “1”, then the message will be tagged for Economy delivery. If DelType is 
set to “2”, then the message will be tagged for Urgent delivery. Messages 
sent to non-CallPilot recipients with the Delivery Type set to Economy will 
be delivered on a schedule defined by the CallPilot server for Economy 
delivery. Note that messages sent to CallPilot mailboxes will not be affected 
by the Economy designation and will be sent as Normal messages. 
Transmission of messages tagged as Normal or Urgent will begin 
immediately. Urgent messages will display the Urgent icon when displayed 
from My CallPilot or a Desktop Messaging client and a voice prompt will 
identify the message as Urgent from the CallPilot telephone interface. 
Messages sent Urgent are treated as Normal when they are sent to 
non-CallPilot addresses.

4 Once the table has been updated, save all changes. You would normally supply 
a unique name for your data file here, but for the remainder of these procedures 
the name Data.doc will be used. 

5 Close the document. The Data.doc file can now be used as a data source by MS 
Mail Merge.

Accessing and modifying the example Main document
The Sample.doc file is an example of a Microsoft Word main document. 

1 From the \Program Files\Nortel Networks\CallPilot\nda directory, open 
Sample.doc in MS Word.

This document contains tagged fields corresponding to those in the example Data.doc 
file. You can use this as a template for your own fax or just to practise with. If you 
modified the column header names in Data.doc, you will have to modify them in your 
main document as well.
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First page
The first page of the main document is a special page and does not become part of the 
final fax. Sample.doc is installed with the first page setup correctly.

The purpose of this page is to provide a location to map information in the data source 
to each customized fax document. To signal CallPilot that this as a Fax Batch file and to 
prevent this page from becoming part of the fax, two special control codes must be 
present on the first page:

$SOJ$ Start of Job.  This control signals the fax driver to start processing and
can be placed anywhere on the first page.

/zz Skip this page.  This control can be placed anywhere on the first page
and prevents the first page from becoming part of the fax message.

The CallPilot desktop software will retrieve the Fax Number from the first page of the 
document. Additionally, CallPilot desktop software will retrieve the Recipient Name, the 
Delivery Receipt and the Delivery Type, if they exist on the first page. 

/tp Fax Number. Used to address the fax message. This field is required.

/dr Delivery Receipt. A Delivery Receipt can be turned on or off for each
recipient. This field is optional.
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/tn Name of Recipient. This name is used to identify the record in the Nortel
Fax Batch Status dialog if the fax number is either missing or invalid.
This field is optional.

/dt Delivery Type. Used to mark messages for Normal, Economy or Urgent
delivery. This field is optional.

To complete the page, the Fax Number column header (i.e. <<ToFax>>) must be 
inserted after the /tp control using the Mail Merge insert function. Likewise, the Delivery 
Receipt column header (i.e. <<DelReceipt>>) may be inserted after the /dr control, the 
Name of Recipient field (i.e. <<ToName>>) may be inserted after the /tn control and the 
Delivery Type field (i.e. <<DelType>>) may be inserted after the /dt control.

Note: all Fax Batch controls are case sensitive.

As an advanced fax addressing feature, users can also modify all data in a single 
column without actually modifying the data source file. For example, if an existing data 
source table contains fax numbers for a large number of recipients, but the external 
access number '9' is missing, this number can be added to all fax numbers by modifying 
the control on the first page of the document as follows: 

/tp9<<ToFax>>

In this example, a '9' will be added to the beginning of each phone number during fax 
batch processing. The data source remains unchanged and could be used from a 
different location which does not require a '9' for external access.

Second page
Once the data source document and the first page of the main document have been 
created, you can begin to customize your fax. Note that it must be equal to or less than 
8.5 inches in width.

You can use all of the data source column header tags to customize the document. The 
following is an example using the Sample.doc file:
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In this example, the document is customized for each recipient. Data source column 
headers are inserted into the document using the MS Word Mail Merge utility Insert 
function. After the main document has been customized, it is ready to be merged with 
the information in the Data.doc file. Consult your MS Word Mail Merge help for more 
details on inserting data source fields into the document.

Merging data from the Data Source into the Main Document
When you are ready to merge data from the data source file into your main document:

1 Start Mail Merge from the MS Word Tools menu. Depending on which version of 
MS Word you are using, Mail Merge will be under different menu headings. 
a. In the Office XP version, select Tools>Letters and Mailings>Mail Merge 

Wizard.
b. In Office 2000 select Tools / Mail Merge

2 Verify that Sample.doc is currently selected as the main document and that 
Data.doc is currently selected as the data source.

3 Select Merge to Printer and then select the Nortel Fax Batch driver from the Print 
dialog box that appears.
Note: Ensure that MS Word is not set up to print pages in reverse order.
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4 Click OK in the Print dialog box to initiate the batch fax process.

When the document is merged, data values from the data source file will be merged 
into the main document at the appropriate tag positions and a separate fax TIF file for 
each recipient is created. CallPilot desktop software will address and transfer the fax 
files to the server. The CallPilot server is responsible for actually sending the fax to the 
recipients.

Once the process starts, the Print Status dialog appears. The page number increments 
as each page is converted to a TIF file. Since the first page is skipped, this page is not 
included in the count. For example, if a three page fax is sent to 10 recipients, the dialog 
box will display "Printing page 1", "Printing page 2", and so on up to "Printing page 20." 
Only 20 pages are printed because the first page of each document is skipped.

Problems that occur while creating the fax images or with the fax addresses will be 
displayed in a separate Nortel Fax Batch Status dialog box such as:

Problems such as a missing fax address or an unsupported fax address format are 
checked. However, problems such as a wrong fax number will not be identified, 
provided the number is in a valid format. A wrong fax number will however result in the 
sending of a non-Delivery receipt to the user's CallPilot mailbox by the CallPilot server.

When you click the OK button, the batch process ends and no faxes are sent. You must 
then fix the fax address(es) and resubmit the job.

If all faxes and addresses were created properly, a dialog appears while the faxes are 
being addressed and transferred to the CallPilot Server. It indicates the status of the 
batch job. If you press Cancel in this dialog box before the job is completed, another 
dialog box appears asking you to confirm the cancellation. If you select Yes, all 
temporary files will be deleted and the process ends. However, all faxes that have 
already transferred to the CallPilot server will be sent.
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If a problem occurs while transferring the fax, a dialog similar to the following appears:

If you select Yes, an attempt is made to resend the fax to the server. If you select No, 
the current fax is skipped and processing begins on the next fax in the list. The fax that 
was skipped will not be sent. If you select Cancel, another dialog box appears asking 
you to confirm the cancellation. If you choose Yes, all temporary files will be deleted and 
the process ends. Any faxes that have already been transferred to the CallPilot server 
will be sent. If you choose No, the failure dialog box shown above will be displayed 
again, allowing you to make a different choice.

After all the faxes have been successfully transferred to the server, a dialog box will 
confirm this.
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Using custom fax Cover Pages
Callpilot users can choose to include a cover page with their faxes. These are typically 
designed and managed by the server administrator. The user simply chooses the 
desired style of cover page (if more than one is available).

Cover pages created with these tools will include the following general information:

From Information: Title    Name Department   Company   

Phone number Fax number 

To Information: Title    Name Department   Company

Phone number Fax number

Number of Pages

Sent Date & Time

A Cover Sheet Memo section

CallPilot Configuration
The CallPilot Desktop Messaging Configuration page includes an option labelled 
"Include cover page when forwarding fax message". The default value for this is 
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unchecked, meaning that a cover page will not be sent.  

If you select this option, you can then choose and set a default cover page from a list of 
available cover pages. Use the "Browse…" button to choose the location where the 
cover pages are stored. The default location is:  \\Program Files\Nortel Networks\ 
CallPilot\cvrpages.

CallPilot Desktop Messaging Custom form
The CallPilot Desktop Messaging Custom Fax Forward form contains a menu item 
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named "Cover page", which contains two submenus items: "Add" and "Modify".

The "Add" menu displays a list of existing cover pages available to use. You can select 
one of these and click OK.

The "Modify" menu displays the current cover page content and lets you modify it. From 
the "Modify" window, you can also preview the current cover page.

If you enabled the "Include cover page…" option, CallPilot Desktop Messaging will add 
the selected cover page to the Fax Forward form. The cover page will appear as the 
first attachment on the list of attachments (left pane). The Attachment's view (right 
pane) will contain only the Cover Sheet Memo section of the cover page. You can 
include any additional required information here. 
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Nortel Fax Printer Driver form
You can use the Nortel Fax Printer form to send a fax message using either a CallPilot 
Desktop messaging client (such as Lotus Notes) or the QuickFax feature. The 
QuickFax feature allows you to send a fax directly from the Print dialog box. If you 
choose to send your fax using a CallPilot Desktop Messaging client, the cover page will 
be available from the CallPilot Custom form. 
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If you choose to send your fax to a specific destination (for example, a fax machine), the 
Cover page field becomes active and lets you browse for a cover page and/or select 
one from the dropdown list. You can then modify its contents. This provides functionality 
similar to the Custom form. (Refer to the following section for details.) You can also 
choose not to include a cover page by selecting the No cover page option from the 
Use fax cover page dropdown list. Note that you can also include a Subject line here.  

The Subject field information will only be displayed in the e-mail portion of the fax. It will 
not be displayed on a hard copy of the fax.

Modify and Preview cover page
You can preview the current cover page and modify its contents from both the CallPilot 
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Custom form and the Nortel Fax Printer driver application.

Click on Preview to view the current state of the cover page.



31

The first time you access this page, CallPilot Desktop Messaging will try to fill in the 
From section using information from the registry. Desktop Messaging will remember the 
data that you entered into this section and automatically complete those fields the next 
time you use this page. Although the From information is automatically populated from 
the registry, you can still change it.

In the To section, one field will always be read only - the Fax field. CallPilot will populate 
it using address information from the Custom or Fax Driver forms. The Name field is 
read-only if the cover page is used from the Custom form. In this case, CallPilot will 
automatically fill it using the recipient's name. If you use the Fax Printer driver instead, 
this field is left empty and you can complete it.

If a cover page is used from the Fax Printer driver, CallPilot Desktop Messaging 
computes the number of pages and enters this information in the Pages field. When you 
use the Custom form, the Pages field is left empty. You can modify this field in either 
case.

The Sent field uses the current time and date by default. This field is also editable.

The Memo section is in synch with the Memo section of the Custom form.

Note that the maximum length of all cover page fields except the Memo field is 30 
characters. The maximum length of the Memo field is 2500 characters.
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Calling the sender of a message
You can respond to a CallPilot or a Lotus Notes e-mail message with a telephone call 
instead of a recorded message.

1 Select a message in your CallPilot or Lotus Notes Inbox.

2 Choose the Sender item from the Tools>CallPilot Desktop Messaging>Call menu

or click the Call Sender toolbar icon .
The e-mail sender’s address book entry may contain multiple numbers. Therefore 
all telephone numbers that can be found for the sender in the Office, Home or 
Mobile fields are presented to you in the Call Verification dialog. Choose the 
appropriate number and press the Call button. The CallPilot Desktop client will 
remember any changes you make if you select the Remember Changes 
checkbox.

3 Answer the telephone when it rings. CallPilot immediately calls the sender of the 
message.

4 When you finish the call, hang up the telephone or click Disconnect .

Forwarding and replying to messages
You can forward a message and append an introduction to it. You can also compose a 

reply to the sender of a message, or to the sender and all recipients of a message.

Note:  Your administrator may block messages forwarded to external e-mail addresses.

To forward or reply to a message
1 In an open message, click 

Forward, Reply, or Reply to All.

2 On the new message form, 
compose a voice, fax, or text 
message. 

3 Address forwarded messages the 
same way as a new message. 
Replies are addressed 
automatically.

4 Add attachments, set options, and 
change the subject line if required.

5 Click the Send Message icon.

Compose voice message
Compose text message

Attach file
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Adding attachments to messages
Before sending a message, you can attach a voice, fax, or text file to it. Voice files can 
be .vbk or .wav format for CallPilot recipients; CallPilot can automatically convert .vbk 
files to .wav files when sending to non-CallPilot users. See Changing mail delivery 
settings, on page 40. Fax files must be .tif format. Text files must be .txt format. 

Setting message options
Before sending a message, you can set options for handling and delivery.

To set message options
1 On a new message form, select Delivery, Sensitivity, and Receipt options, as 

required.

For Delivery, select Urgent, or leave the setting as Normal.
For Sensitivity, select Private, or leave the setting as Public. 

When you send a message marked Private, your recipient can forward it to 
someone else, if they are not a CallPilot user. Also, recipients in non-CallPilot 
systems will not be informed of Private settings. In your message, tell the recipient 
that the message is Private.
For Receipt acknowledgment, check Read receipt to request acknowledgment 
that your recipient opened the message. Check Delivery receipt to request 
acknowledgment that your recipient received the message.

2 Continue to compose, address, and send the message as usual.

To attach a file to a message
1 On a new message form, click the 

Attach File icon.
2 In the Open box, select or type the 

name of the file that you want to 
attach. 

3 Click Open to attach the file and 
return to the new CallPilot 
message. 
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Addressing messages
Callpilot users can access a variety of address books to address messages. These 
include the CallPilot or Lotus Notes Public Address Book (located on your CallPilot or 
Lotus Notes server respectively) or your Personal (local) Address Book. An address 
can be either internal or external to your organization.

To address a message using a Lotus Notes Address Book
A Lotus Notes Public Address Book contains number information fields named “Office 
phone” and “FAX phone”, and CallPilot users can directly access these numbers. (Note 
that in a Lotus Notes Personal Address Book, these fields are called “Office phone” and 
“Office fax” respectively). 

To address your message:

1 In a new CallPilot message, click To…
2 In the Address Book field, select the address book that you want to use. If the 

Lotus Notes Public Address Book is selected, an additional "Filter" drop-down list 
box is displayed. Using this control, you can specify what type of address to use.

If "E-Mail Addresses" is selected, the address list will display all names. 
If "FAX Numbers" is selected, the address list will display names that have 
"FAX phone" information. 
If "VOICE Numbers" is selected, the address list will display names that 
have "Office phone" information. 

Note: You can address the same message to different types of recipients. 

3 Select the recipient(s) from the list of names. Group names are in square 
brackets. You can select more than one address at a time. If you address a 
message using Voice or Fax numbers, you will be prompted to pick and verify the 
final destination.

4 Click To ->, Cc ->, or Bcc ->, as required.
5 Click OK to return to the new CallPilot message.
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To address a message using a CallPilot Address Book 
The CallPilot Address Book on the server is maintained by your organization, and 
contains the addresses of the CallPilot users and distribution lists that you are allowed 
to use. You cannot edit this list. 

Lotus Notes Desktop clients access the CallPilot Address Book through a dynamic 
lookup utility. This feature allows you to access the CallPilot Address Book without 
requiring you to maintain CallPilot address information in your Lotus Notes Personal 
Address Book. However, you can download CallPilot address information to your 
Personal Address Book if you want to address messages in offline mode. Such 
addresses cannot be validated in the offline mode.

To address your message:

1 Log on to a CallPilot server if you have not already done so.

2 Select the CallPilot Server Address Book from the list of available address books. 
When the CallPilot Address Book is selected, additional controls are made 
available to dynamically search for CallPilot addresses on the CallPilot server in 
a number of ways. For example:
a. Select the search type "Last Name" in the "Search for:" combo box.

b. Enter a set of letters into the text field.

c. Click on "Search". All records with the last name matching the letters will be 
returned and displayed in the address list. 

Note: You can continue to change search types and/or modify letters until you 
find the desired name. If you enter a name that has not been downloaded, a 
dialog displaying the number of addresses to download may appear while the 
search proceeds.

3 Select the recipient(s) from the list of names. You can select more than one 
address at a time.

4 Click To ->, Cc ->, or Bcc ->, as required.
5 Click OK to return to the new CallPilot message.

To address a message manually
You can type an address directly into the To field of a new message without opening 
the "Mail Address" dialog. Type the address with no spaces, and enclose it in double 
quotes. The name will be resolved against all available address books and address 
types. If more than one address is found, you will be presented with a "CallPilot 
Recipient" dialog showing all the matching addresses. Choose which address to use for 
the message. You can modify Phone or Fax numbers here, but not CallPilot or E-mail 
addresses. 

If you are a Lotus Notes user on a Terminal server, you cannot download CallPilot 
message addresses into your Personal Address Book. This address book is not 
availabe to Terminal server users when addressing Callpilot messages.
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Required format for a CallPilot E-mail address
If you choose to enter a CallPilot addresses in the E-mail field, it must be entered in the 
following format:

[CALLPILOT:XXXXYYYY@ZZZZ]

Where:
XXXX = SMTP/VPIM prefix
YYYY = CallPilot Mailbox number
ZZZZ = CallPilot Server FQDN (server and domain)

For example, suppose CallPilot server “na42349” in the domain “us.nortel.com” with 
VPIM/SMTP prefix “1952897” contains mailbox “7404”. Then the CallPilot address for 
that mailbox would be: 

[CALLPILOT:19528977404@na42349.us.nortel.com]

Required format for Fax and Telephone Numbers
If you choose to enter a fax or telephone number in the contact field(s), it must be 
entered as an alphanumeric string. Pause (P p  ,) and octothorpe (#) characters are 
supported. 

The required format is:

[CALLPILOT:XXXX@ZZZZ]

Where:
XXXX = Telephone or fax number
ZZZZ = CallPilot Server FQDN (server and domain)

Examples of valid fax and telephone number formats are:

[CALLPILOT:7404@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321,7404@na42349.us.nortel.com]
[CALLPILOT:(416) 697-7321p7404@na42349.us.nortel.com]
[CALLPILOT:(800) 921-1342#123123@na42349.us.nortel.com]

To download CallPilot addresses to your Personal Address Book
You can optionally download the names and addresses of CallPilot users to your 
Personal Address Book. This is useful if you are working in offline mode. In the 
online mode, Lotus Notes Desktop Clients can dynamically query and retrieve 
addresses from the CallPilot server address book at any time. See Changing your 
address book settings, on page 42.
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Restrictions
When you submit a message to the CallPilot server for delivery to a telephone or fax 
number, the CallPilot server reviews the Restriction Permission Lists (RPL) to validate 
that the sender has the necessary permissions. The same rules that determine if a 
number can be dialled from your telephone will be applied to the destination number of 
the outgoing voice or fax message.

If you lack the necessary permissions (for example, cannot utilize voice channels, 
cannot place long distance calls, etc.), a Non-Delivery Notification (NDN) will be 
generated. An NDN will also be generated for the recipient if the destination number is 
deemed invalid.
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CallPilot distribution lists
You can create a Personal Distribution List (PDL) over the phone or in My CallPilot.
Using the Lotus Notes client, you can also create a Group in the local or public Lotus 
Notes address books. However, Lotus Notes address books are not accessible from 
the telephone or from My CallPilot.

To use existing CallPilot personal distribution lists
You can address messages using CallPilot personal distribution lists that you created in 
My CallPilot or on your telephone. In Lotus Notes, select these lists from the CallPilot 
Address Book.

To create a CallPilot group
You can create a personal distribution list for a group of recipients to whom you 
frequently send messages. After you create a list, it appears in your Personal Address 
Book in Groups (CallPilot).

You create a CallPilot group in the same way that you create an e-mail group. The 
CallPilot group can contain CallPilot and e-mail addresses.

1 In your Lotus Notes Inbox, click the Address Book icon.

2 Select Groups (CallPilot), then click the Add Group button.

3 Enter a Group Name and Description, then click the arrow beside Members.

4 In your Personal Address Book, place a check mark beside each name that you 
want to add to the group. Click OK to exit the list.

5 Click the Save button.
6 Click the Close button.

You can edit or delete the list in Groups (CallPilot).
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Changing your mailbox settings

To view or change your CallPilot access settings
Your administrator enters the default CallPilot access information for you. You can 
change these settings if required. Refer to the online Help for a detailed explanation.

1 In your Lotus Notes Inbox, on the Actions menu, click CallPilot Desktop 
Messaging > CallPilot Configuration. 
OR
On the CallPilot Player, select View > Options.

2 Click the General tab to display your current access settings.

3 Make any changes required, then click OK.

To change your CallPilot password
This is the same password that you use on the telephone.

1 Repeat steps 1 and 2 above, 
then click Change Password.

2 In the Old password field, type 
your current password.

3 In the New password field, type 
your new password.

4 In the Retype new field, type 
your new password again.

5 Click OK to save the change.

6 Click OK to exit the General 
settings.
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Changing mail delivery settings

To view or change your mail settings
Your administrator enters the default mail settings for you. You can change them if 
required. Refer to the online Help for a detailed explanation.

1 In your Lotus Notes Inbox, on the Actions menu, click CallPilot Desktop 
Messaging > CallPilot Configuration.

2 Click the Mail tab to display the current mail settings.

3 The following settings are available:

Notification - You can set CallPilot to update your message list automatically, 
manually, or at intervals such as every 5 minutes. (Choose Manually to save 
costs on long distance or ISDN connections.)
Lotus Notes Auto Refresh is enabled by default. When enabled, all CallPilot 
Desktop messaging views (All, Inbox, Drafts and Sent) will automatically update 
when new CallPilot messages arrive. The effect is similar to using Lotus Notes 
"View\Refresh" menu or hitting F9 key. The refresh will only take place when 
viewing a CallPilot view and will not affect Lotus Notes views. There is no need to 
refresh when viewing a Lotus Notes view. CallPilot views will be refreshed by the 
Lotus Notes client when you open one of the CallPilot views. However, if you 
have a large number (thousands) of e-mail or CallPilot messages, the Lotus 
Notes Auto Refresh may impact the network performance when a new CallPilot 
message arrives. Therefore, users have the option to disable the Refresh to 
prevent network problems by deselecting this checkbox. Note that when this 
option is disabled, you will have to refresh CallPilot views manually by using 
Lotus Notes "View\Refresh" menu, hitting F9 key, or changing the current view.
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Include a message header when forwarding/replying - The header information of 
the original message appears in a reply or forwarded message. 

Include a cover page when forwarding a fax - Refer to the "CallPilot 
Configuration" section on page 25 for information regarding adding and/or 
modifying cover pages.

Convert voice messages to WAV for non-CallPilot users - Your recorded 
messages are automatically converted from .vbk to .wav files when you send 
them to non-CallPilot users. 
Show message waiting indicator (MWI) on taskbar - The CallPilot telephone icon 
on the Windows taskbar turns red when you have a new message.
Create a sent item - A copy of each sent message is stored in the Sent folder.

4 Click OK.
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Changing your address book settings

To view or change your Address Book settings
Your administrator enters the default Address Book settings for you. You can change 
them if required. Refer to the online Help for a detailed explanation.

1 In your Lotus Notes Inbox, on the Actions menu, click CallPilot Desktop 
Messaging > CallPilot Configuration.

2 Click the Address Book tab to display the current Address Book settings.

3 Make any changes required, then click OK, or proceed to download your address 
book as described below.

To download the Address Book to your computer 
You can download the names and addresses of CallPilot users to your Personal 
Address Book.

1 In your Inbox, on the Actions menu, click CallPilot Desktop Messaging > 
CallPilot Configuration.

2 Click the Address Book tab.
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3 Check the Remind me... box and specify the number of days between 
reminders.

4 Click Download Now.
5 Click OK.
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Changing audio settings

To change the audio device and volume
You can play and record your messages from your telephone or your computer. 

1 In your Lotus Notes Inbox, on the Actions menu, click CallPilot Desktop 
Messaging > CallPilot Configuration. 
Or
On the CallPilot Player, select View > Options.

2 Click the Audio tab to display the current Audio settings.

3 In Device, select Telephone if you want to play and record your voice messages 
from your telephone. Make sure the correct telephone number appears.
Or
Select Computer if you want to play and record your voice messages through 
your computer’s speakers and microphone.

Note: You can change your audio device on the CallPilot Player also.
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4 In Volume, check the two Volume check boxes if you want to coordinate your 
CallPilot volume settings with your computer’s speaker and microphone 
volumes.

5 If you want a reminder to check these settings before playing or recording voice 
messages, check Confirm settings... .

6 If you want to download voice messages to your computer before playing them, 
check Download file... . This option is useful if you are using a modem.
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Linking to My CallPilot
Desktop Messaging provides links to the web-based resources in My CallPilot. To view 
or change the URL for My CallPilot, see Changing your mailbox settings, on page 39. 
For more information on My CallPilot, refer to the My CallPilot User Guide.

1 In your Lotus Notes Inbox, on the Actions menu, click CallPilot Desktop 
Messaging > CallPilot Desktop Messaging Tools > My CallPilot.

2 Select one of the tabs.

To view or change your CallPilot feature settings
1 In My CallPilot, click the CallPilot Features tab.

2 Select any feature and make changes to your setup as required. Any changes 
you make to a feature go into effect immediately whether you use CallPilot from 
your computer or from your telephone.

To view user information
In My CallPilot, click the Useful Information tab to view online user information 
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specific to your mailbox.
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Working offline
To work offline, you will require a computer that has CallPilot installed and configured in 
the same way as your office computer. You can download your messages and 
addresses to this computer before working offline.

1 (Optional) You may want to download your CallPilot messages to the computer 
that you will use offline. Log in to your e-mail and CallPilot, and in your Inbox, 
click Download all CallPilot Messages. When your messages are downloaded, 
log out.

2 (Optional) You may want to download the server Address Book to your computer. 
See Changing your address book settings, on page 42.

3 Open your e-mail while not connected to the network, and wait for the CallPilot 
Logon window to appear. You do not need to enter your password. 

4 Click Cancel. 
You can then work offline, reviewing your messages and recording and addressing new 
messages. You must use your computer’s speakers and microphone to play and record 
messages offline; you cannot use a telephone for offline access.

CallPilot stores your recorded messages and sends them the next time you log in to the 
CallPilot server.
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